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 Skycut EV24 with SignMaster Pro  
 

March 21, 2023 
 

 

• Do NOT read this entire manual… unless you want to. But taking the time to familiarize yourself with the 
organization of the manual and the topics covered can assist you in finding the answers you might need. 

 
 
It’s not practical to print this entire manual because: 

• It’s a waste of paper and ink if you only ever need certain sections. 

• The live links to videos and web sites in the manual will not work. 

• This manual will be updated from time to time. 

• You cannot search on individual words. Use Ctrl+F (or command+F on a Mac) to locate all instances of a 
particular term. 

 
Also: 

• Videos of interest can be found at the following link:  Skycut Support Videos 
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1. Introduction and Setting Up 
 
 
 

1.0 Quick Reference for This Chapter 

• How to use the control panel: Sections 1.9 

• How to adjust the blade holder: Section 1.7.4 

• Where to position the pinch wheels: Section 1.8 

• The cutting mat is too sticky (or not sticky enough): Section 1.7.5 

 

Important Notes: 

• Please read Section 1.2 regarding safe operation of the Skycut. 

• Report any damage or missing contents to your dealer promptly. 

• Retain the original box and packing materials in case you ever need to ship your Skycut. 
 
 
 

1.1 Support 

• Thank you for choosing a Skycut EV24 digital die cutter. Before using a blade in your new cutter, we urge 
you to practice with the test pen, making sure you understand where shapes will cut. 

• If you run into difficulties with the operation of your Skycut, turn off the power and look for a solution in this 
manual. Note that Appendix A is a Troubleshooting section.  If you continue to have technical questions or 
issues, please contact your dealer as soon as possible. 

• If anything is missing from your order or you have mechanical issues with your Skycut, please contact your 
dealer as soon as possible. You can also contact Skycut directly using this email address: 
skycut@skycut.cn.  

• For additional information and support with the Skycut, please check out the following: 

 Skycut web site: https://www.skycutcutter.com/ 

 Skycut Facebook page: https://www.facebook.com/skycutcuttingplotter/ 

 Skycut Facebook group: https://www.facebook.com/groups/Skycut 

 Skycut YouTube channel: https://www.youtube.com/channel/UCrPn5hFLbiRNDgccY8iXwoA/videos 

• For SignMaster support, please go to http://signmaster.software/support/ 
 
 
 

1.2 Safety and Warnings 

Please be aware of the following safety guidelines when working with the Skycut: 

• Pinch Points:  Keep hands, long hair, loose clothing, jewelry, etc. away from the moving parts. 

• Risk to Children and Pets:  Please supervise children around the cutter when it is in use.  

• Movement and Touching:  Do not move the Skycut itself or touch any circuitry while it is plugged in.  

• DO NOT attempt to move the blade carriage while the cutter is powered on. 

• DO NOT touch or jam the plotter’s track while it is operating.  

• DO NOT shake the cutter while it is operating. 

• DO NOT cut any materials that have staples or other embellishments attached. 

https://www.skycutcutter.com/
https://www.facebook.com/skycutcuttingplotter/
https://www.facebook.com/groups/Skycut
https://www.youtube.com/channel/UCrPn5hFLbiRNDgccY8iXwoA/videos
http://signmaster.software/support/
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• DO NOT touch the cutter with a magnet. It is safe, however, to cut magnetic materials, such as those used 
on refrigerators and car exteriors. 

• DO NOT allow any liquids to spill or small items to fall into the cutter. 

• Mount the EV24 on its included stand or place it on a sturdy and stable table, desk, or trolley.  

• Always turn off the Skycut when not in use. Leaving the cutter turned on for extended periods of time can 
possibly damage the machine. 

• Always turn off the Skycut before unplugging or removing the power cable from the wall outlet or power 
strip. 

• Unplug the Skycut from a wall outlet or power strip during an electrical storm or when the cutter will not be 
used for an extended period of time. 

• Transporting: When transporting the cutter, move the pinch wheel levers into the upward position. Remove 
the blade from the blade holder and cover the tip of the blade with the plastic cap.  

 
 
 

1.3 Warranty 

• IMPORTANT! If your Skycut is damaged during shipment or appears to be defective, your dealer should be 
notified as soon as possible.  

• For additional information regarding your warranty, please refer to your Skycut dealer.  

• It is recommended that you retain the original box with packing materials in case you ever need to ship your 
Skycut. 

 
 
 
1.4 Unpacking      

• Verify that you have received all contents. There is a checklist in Section 1.05. Please notify your Skycut 
supplier immediately if anything is missing. 

• Remove all packaging before turning on the Skycut. Currently, the cutter ships with two end cap foam 
protectors, zip ties on either side of the blade carriage, and tape on either end of the cutting strip. Be very 
careful when removing the zip ties – it’s best to cut those ties from behind the machine versus in front. 
Gently remove the tape at the ends of the cutting strip by rolling the tape away.  Do not pull straight up. 

• Because the cutting mat must be folded over to fit into the box, it may have become slightly rounded during 
shipping. Gently and only partially roll the mat in the opposite direction to remove the roundness and place 
on a flat table to make sure the mat now lies horizontally to the surface.  Refer to Section 1.7.5 for additional 
instructions on preparing the mat for use. 

• Use the enclosed test pen as you experiment and become familiar with operating the Skycut. Place scrap 
paper on the mat and simply draw shapes rather than cut them. This will prevent possible damage to the 
blade, mat, and cutting strip as you learn where shapes will cut and the basic operating procedures. 

 
 
 

1.5 Contents    

• Besides the EV24 cutter and cutter stand, your box should also contain the following items: 
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1.6 Parts of the Skycut      
 

Front 
 
 

 
 
 

          

• Alignment Markers: indicate to the user the available positions for the pinch wheels 

• Blade Carriage: moves the Blade Holder Seat left and right 

• Blade Holder Seat or Jaw: holds the blade holder, test pen, and other accessories 

• Control Panel: used to change settings, set up Wi-Fi, cut PLT files, and more 

• Cutting Strip: protects a blade when cutting backed materials without using a cutting mat 

• Grit Shafts (5 in total on EV24): allow the pinch wheels to grip the mat or material so they can be moved in 
and out of the cutter during cutting 

• Pinch Wheels (4 in total on EV24): grip the mat or material so that the grit shafts beneath will feed the mat 
or material in and out during cutting 

• Ruler: for measuring and aligning rolled materials 

 

Left 

End 
Cap 

Control Panel 
Alignment Marker 

 
Pinch Wheel 

 

Right 

End 
Cap 

 

Carriage 

Ruler Cutting Strip  
(light gray and smooth) 

Grit Shafts  
(dark gray and rough) 

Blade Holder Seat  
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Front with Cover Open 

 

 

 

 
 
 
 
 

Right Side 

 
 

 
 
 
 
 
 
 

Left Side 
 

 
 
 

 
 
 
 
 
 
 

Reset 
Button USB Flash 

Drive Port 
USB Port 

• USB Flash Drive Port: used to load PLT files via 
control panel for cutting 

• USB Port: option to connect computer to Skycut 
with included USB cable 

• Reset Button: used to reset Skycut’s cutting 
buffer (does not reset calibrations) 

 

• Power Port: plug power cable into this port 

• On/Off Switch: power cutter on or off 
 

On/Off 
Switch 

Power Port 

LED Light 

Alignment Marker 

 

Carriage Belt Grit Rollers  
(dark gray and rough) 

Control Panel Cable 
Head Cable 

Platen 
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Back 

 
 
 
 

 
 
 
 
 
 
 
 

1.7 Accessories 

1.7.1 Assembling the Skycut Stand 

• If you purchased the optional stand, please refer to this    for detailed instructions on assembling the 
stand and mounting the cutter onto it. 

 
 

1.7.2 Test Pen 

• The test pen is used in calibrating the Scale (Section 3.8) and is also recommended for test drawing while 
you are learning where shapes will cut based on various software settings. Note that a small piece of wax 
needs to be removed from the pen’s nib before use. You may also wish to cut off the very top of the pen 
refill so that it more easily fits into your EV24: 

 

 
 
 
 
 
 

1.7.3 Skycut Blades 

• There are three kinds of blades that fit inside a Skycut blade holder:  

Spring goes over the top of the pen insert 
and stops at a small ridge on the insert 

• Pinch Wheels (4 on 24” model): grip the mat or material so that the grit 
shafts beneath will feed the mat or material in and out during cutting 

• Pinch Wheel Lever: raises and lowers the pinch wheels 

 

Pinch Roller Lever 

Pinch Rollers Platen 

Right 
Cover 

Left 
Cover 

https://drive.google.com/file/d/16i2e6_f3XqVNit3-Vl9VZ6aDiJ2CL4sw/view?usp=sharing
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 The 45° red capped blade is suited for cutting thinner materials such as paper, all cardstock types, heat 
transfer vinyl, and wall/auto/decal vinyl.  

 The 60° blue capped blade is a much longer blade and is well-suited for cutting thicker materials, such 
as gum paste, craft plastic, craft foam, and rhinestone template material. 

 Sold separately is the 30° yellow capped blade. It is a wide blade and is well suited for cutting thin 
fabric and window tint film. It has been reported that it also works well with cardstock that has been 
exposed to humidity. 

• Note that the blades all have a cutback on the opposing side of the blade (right side, in the prior photo). This 
reduces the blade offset value and allows for better detailed cutting of small shapes.   

 
 

1.7.4 Blade Installation  

• The blade must be carefully inserted into the blade holder.  Do this over a soft surface (e.g., over a hand 
towel). It’s important to protect the fragile blade.  To install, follow the numbered steps as shown: 

  

 

 

 

 

 

 

• The Blade Length (also called Blade Exposure or Blade Depth) is how much blade is exposed at the 
bottom of the blade holder.  For optimal cutting, you want this length to match the thickness of the material 
or be just a tiny bit longer.  

• When setting the Blade Length (Step 4 in the prior photo), hold the blade holder up next to the material 
before pressing the material to the mat, so that you can more accurately set the length to match the 
thickness of the material. For very thin materials, like vinyl and thin paper, just the very tip of the blade will 
be protruding from the bottom of the blade holder. In fact, you should just barely be able to feel it with your 
fingertip and not be able to see it very well, if at all. Having the blade fully extended will never result in better 
cutting. In fact, it can cause skewing, tearing of the material, damage to the blade, and damage to the mat 
or cutting strip.  

• A good way to test your blade length is to fold a piece of the material onto itself and then cut a line into the 
material by hand. Press firmly but not too hard, as more force will not determine if the blade is set to the 
right length. If the blade cannot cut through the material, you will need to extend the blade. If the blade cuts 
through the material and cuts into the next layer, you need to retract the blade. If the blade cuts through the 
material but does not cut into the layer below, you have the perfect length.  

 

 Red                Blue        Yellow 

3. Turn the brass ring 
counterclockwise until 
loosened. 

4. Turn the large ring clockwise or counter-
clockwise to set blade length to match the 
thickness of the material being cut. 

5. Turn the brass ring clockwise 
until locked back in place. 

1. Push in this button 
and hold so that a blade 
can be inserted OR 
removed. 

2. Gently insert non-sharp end 
of the blade into the holder. 
An internal magnet will pull 
the blade inwards. 
 
Then release the button on 
top of the holder 
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• When conducting a test cut, be sure to check your mat (or the top of a backing sheet) for cut lines after the 
test. You should be able to set the length to get clean cuts but with only fine lines or no lines in the mat or 
backing sheet. If you do see deep cut lines, retract the blade length ~¼ of a turn counterclockwise. Repeat 
your test cut. 

 
 

1.7.5 Cutting Mat 

Tips on Using the Cutting Mat 

• Always use a mat to hold the material to be cut unless the material has its own protective backing. For 
example, vinyl and iron-on transfer both come with a layer that you do not cut. Thus, this backing layer 
serves as the carrier for cutting.  Paper and cardstock do not have a backing, thus they must be cut on the 
mat. 

• IMPORTANT!  A new mat may be too sticky if you are cutting certain products. This can cause difficulty in 
removing cut items without tearing. Place an old but clean bath towel over the surface of the mat and press 
with a brayer or rolling pin.  Then pull up. Test the stickiness by pressing the palm of your hand in the middle 
of the mat and lifting. If the mat remains stuck to your hand, repeat until the mat can still be lifted but will 
release. It should only take a few pressings to greatly reduce the stickiness, as tiny (too small to be visible) 
fibers from the towel are added to the surface. 

• Do not leave the pinch wheels in a down position when the Skycut isn’t in use. This warps the plastic 
sooner, shortening the useful life of the cutting mat.  

 
Cleaning and Replenishing the Cutting Mat 

• When mats begin to lose their stickiness, they can be washed: 

 Use a mild dishwashing detergent, warm water, and a soft brush to thoroughly clean the surface. You’re 
not trying to scrub the adhesive but just wet the invisible fibers that have been deposited from your 
cutting materials and get them released from the glue. 

o Rinse well, shake off excess water, and place sticky side down onto a bath towel.  

o Thoroughly dry the non-sticky side of the mat with another towel.  

o Pull the mat up and the sticky side should now be dry enough for immediate use. Test by making 
sure the mat will stick to your hand.  

• While washing with soap and water should revive the original adhesive, you can add more adhesive if 
necessary:  

 Virtually any repositionable adhesive may be used on the cutting mat. Some of the popular choices 
include: Krylon Easy Tack, Aleene's Tack It Over and Over (view the video at the start of this section), 
Crafter's Companion Stick and Spray, Zig 2 Way Glue with wide tip, Craft Smart Off 'N On, and Scotch 
Repositionable Craft Stick. There’s another spray adhesive, Scotch Super 77, which does not leave a 
sticky surface but is excellent for stabilizing paper and cardstock.  

 If you are cutting thicker materials, such as oil board or styrene, then you may want to experiment with a 
stronger adhesive and use painter’s tape to secure the material to the mat. If you are cutting thin paper, 
then you may want to experiment with a lighter adhesive.   

Mat 

Material 

 Perfect Length                 Too Long                            Too Short  
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 With most repositionable adhesives, you can control the tackiness based on the amount applied. Thus, 
always add a little bit at a time.  As mentioned above, if you add too much, just apply a layer or two of 
cotton fibers by pressing with a bath towel.  

• Other reported methods for cleaning mats: 

 Use a plastic scraper (an old credit card will suffice) to scrape off any random material pieces remaining 
on the mat after a cut.   

 For finer particles of paper or lint, you can use a lint roller. Tear off a sheet and then press down and pull 
up across the surface of the mat to clean in sections. Baby wipes can accomplish the same task. 

 To completely remove adhesive from the mat, apply Goo Gone, Duck Adhesive Remover, or Avon’s Skin 
So Soft Bath Oil across the surface. Allow a minute to soak in and then scrape off with a sharp metal 
spatula. Repeat, as necessary, until the mat is thoroughly clean and no longer sticky. Wash, dry, and 
then add any repositionable adhesive.  

• When necessary, the rubber wheels and the grit shafts may be cleaned with isopropyl alcohol or Un-Du. 
Apply the cleaner to a clean lint-free rag and rub the entire wheel and/or grit shaft until free of adhesive.  

 
 
 

1.8 Pinch Wheels 

• The levers on each pinch wheel are used to raise the wheels for loading the material and/or mat and lower 
the pinch wheels for cutting. 

• Lift up an individual lever to raise that pinch wheel: 

  
 

• Note that for a pinch wheel to grip properly, it must be positioned over a grit shaft. To facilitate alignment, 
note the white rectangles positioned along the horizontal bar behind the blade carriage.  With the levers in 
the up position, slide the pinch wheels along the bar, as needed:  

 

• When using the cutting mat, it is recommended that the material be placed in the middle of the mat and the 
mat placed roughly in the middle of the cutter.  Then use the second and fourth pinch wheel locations for 
two pinch wheels. This keeps the pinch wheels off the material and provides an equal balance while the mat 
moves in and out during cutting: 

 

Wheels should be centered over grit 
shafts which are directly below the 
white rectangles 

Pinch wheel is in 
the up position.  
 

Pinch wheel is in 
the down position.  
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• Note that if your material is very wide, then it is fine to have the pinch wheels over the material. However, 
you may need to be extra careful when removing any cut shapes or waste material in those locations. 

 
 
 

1.9 Control Panel 

• When you first power on the EV24, the following SPEED and FORCE Screen or Home Screen will be 
displayed after several seconds: 

      
 

• The functions of the buttons on this control panel are:  

 RECUT:  Recuts the last completed job which is stored in the EV24’s memory.  

 UDISK: Opens the UDISK window allowing access to files on a USB thumb drive plugged into the 
EV24’s USB Flash Drive port. Files must be saved in .PLT format to appear in the menu (See Sections 
2.2.3 and 2.2.4 for details). 

 MENU: Opens a menu of additional functions (See Section 1.9.1 for details). It can also be pressed in 
other modes to return to the SPEED and FORCE Screen. 

 FS: Press this button once and the SPEED and FORCE settings will light up indicating you are in FS set 
mode. The X- and X+ buttons can now be used to change the SPEED. The Y- and Y+ buttons can be 
used to change the FORCE. (See Sections 3.3.1 and 3.3.2). 

 TEST: Press the TEST button to cut a small square. This is recommended to ensure a clean cut is 
achieved with the current settings before proceeding with a cut job.  

 PAUSE: Pressing this button will pause the cutting process in case any changes need to be made. 
Pressing again will resume the cut.  

 X and Y and OK buttons are used in the following ways: 

o The X- and X+ buttons move the carriage left and right, while the Y+ and Y- buttons move the grit 
rollers. This allows you to start cutting anywhere on the media (i.e., establish an origin).  

o As mentioned above, these same buttons will change the SPEED and FORCE settings when the 
FS button has been activated. Pressing OK (or repressing FS) will then deactivate FS mode.  

Middle two pinch wheels 
are placed under 2nd 
and 4th white rectangles 
 

Pinch wheels are approx. the 
same distance from the 
outside edges of the cutting 
mat   
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o In some of the other control panel screens, the X and Y buttons will be used to select other options 
and the OK button will accept these options or changes in settings. 

 
 

1.9.1 Menu 

• Pressing the MENU button provides access to the following five options: 

 

 WIFI: Connect the EV24 to your home or office router for wireless connectivity (refer to Section 2.2.2). 

 Scale: This setting is used to input the sizing calibration (refer to Section 3.8). 

 Advance mode: Three options for where the blade holder moves at the end of a cut: 

 

o To Start: return the blade holder to the origin (the location immediately before the cut was started) 

o To End: advance the blade holder to the top of the completed cut with the option to move an 
additional distance (or retract) 

o To Left: advance the blade holder to the left of the completed cut with the option to move an 
additional distance (or retract) 

 Language: This screen offers a choice of three languages: Mandarin, English, and Spanish.  You can 
choose one of these for the language in which all settings and menu communication are displayed. 

 System: This screen displays hardware and firmware versions, Baud rate, and other settings that 
should need no adjustment unless directed by a Skycut technical representative. 

 
 
 

1.10 Maintenance 

Skycut machines do not require any kind of lubrication or routine checks. However, here are a few things to 
keep in mind for successful operation of your cutter: 

• Keep the pinch wheels clean. Depending on the adhesive being used on the cutting mat, it’s possible for the 
pinch wheels to become sticky and pick up small pieces of cardstock or other material being cut. This can 
lead, in some cases, to the mat skewing or ruining materials during subsequent cuts. To clean the pinch 
wheels, use a lint-free cloth and an adhesive remover such as isopropyl alcohol or Un-Du to clean the pinch 
wheels thoroughly. 

1. Select from 
three options 

2. Enter extra 
feed length, if 
applicable 

Y- / Y+ move up/down 
menu 
 
X- / X+: change 
selection 
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• Keep the grit shafts clean. Equally important as the pinch wheels, the grift shafts beneath the cutting mat 
should also be free of adhesive and tiny bits of material. They can be cleaned the same way as the pinch 
wheels. Note: Do not pour cleaner onto a grit shaft. Instead, dab some adhesive remover onto a lint-free 
cloth and then use the damp cloth to clean the shafts.  You can also use tweezers to remove any material or 
adhesive that is stuck to a shaft. 

• Keep the cutting mat clean and sticky. As mentioned in the Section 1.7.5, the cutting mat can be washed 
with soap and water to remove small invisible pieces of material which are reducing the tackiness of the 
cutting mat. After drying, you can add more repositionable adhesive, if needed. 

• Check your blade holder, as needed. If suddenly you cannot get a clean cut, check the blade holder for any 
tiny slivers of material that may have been caught up by the blade and fed up inside the blade holder.  

• If you cut vinyl or other backed materials regularly, you may need to replace the cutting strip at some point. 
You will be able to tell based on seeing deep cuts in the strip and an inconsistency in the cutting. Contact 
your dealer for information on obtaining a replacement. 

 
 

1.11 Other Useful Tools and Supplies 

• The following list has items you may or may not need while enjoying your Skycut. These are suggestions 
based on twelve years of collecting information from other cutter owners: 

 Brayer or Rolling Pin: (1) to apply lint from a towel onto an overly sticky mat  (2) to press materials 
evenly onto a mat for cutting 

 Post-It Notes: (1) for setting blade/tool tip height above a material  (2) for draw and cut applications   

 Old Fluffy Bath Towel: (1) to dry a washed mat  (2) to apply an invisible layer of lint onto an overly-
sticky mat 

 Dishwashing Soap: (1) to remove visible and invisible fibers from the mat, thus renewing the adhesive 
(2) to clean the mat well before adding more adhesive 

 Soft Brush: (1) to gently remove waste scraps during the washing of a mat. Refer to Section 1.7.5. 

 Artist Palette Knife: (1) to gently remove cut shapes from a mat  (2) to scrape off small waste pieces 
from a mat  

 Blue Painter’s Tape: (1) to tape around the edges of thicker materials that might slip during cutting 

 Repositionable Adhesives: (1) to add more adhesive to a cutting mat (most any brand or type can be 
used, provided it is repositionable). Refer to Section 1.7.5 for suggestions and instructions. 

 Adhesive Removers: (1) to completely strip a cutting mat of adhesive (2) to disarm adhesive long 
enough to remove large scraps of material that will not peel off 

 Lint-free Cloth: (1) for dusting off your cutter and cleaning pinch wheels and grit shafts 

 Awl or Paper Piercer (or other sharp pointed tool): (1) to pick or lift out a test cut to verify results 

 Stabilizers: A stabilizer is an adhesive material that is applied to the bottom of the material you are 
cutting so that cleaner cuts can be achieved. The stabilizer works in one or more of the following ways – 
(1) provides firmer contact with the cutting mat (2) provides a final layer that does not need to be cut if 
the stabilizer will be removed after cutting (3) prevent some slightly-elastic materials from being 
stretched by the blade.  Recommended stabilizers include freezer paper, Thermo-web Heat n’ Bond, 
and Steam-a-Seam 2. 

 Double-sided Tape: (1) For securing metal tags or charms to the cutting mat for engraving 

 Non-slip Shelf Liner: (1) To place under cardstock and other material when embossing 
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2. SignMaster 

 
 
 
 

2.0 Quick Reference for This Chapter 

• How to download and set up SignMaster:  Section 2.1 

• How to set up communication between a computer and Skycut: Section 2.2 

• How to use the USB Flash Drive feature: Section 2.2.3 
 
 
 

2.1 Installing the Software 
 

2.1.1 Installing SignMaster from a Download 

• Once you have purchased a registration for SignMaster, the software can be downloaded from the following 
link. It’s important to use this link so that the Skycut will be installed as the cutter of choice. You will need 
your Product Serial Number that was sent to you. Since you’ll also need this number every time you 
update the software, keep this number in a safe place. 

 
https://signmaster.software/smc.htm 

• Note where the file will be saved on your computer so that you can later browse to that folder and launch the 
.exe file which has been downloaded.   Follow the steps in the following Section 2.1.2, starting with Step (4).  

 
 

2.1.2 Installing SignMaster from a CD 

(1) Remove the CD from the case and insert into the CD ROM drive on your computer. 

(2) The downloaded file is in.exe format, thus ready to launch.  

(3) If Windows Autorun does not initiate a welcome screen, use Explorer to locate and click on the DVD drive 
letter for your computer. Double click on the Welcome file and the following window will open: 

 

(4) Click on Install Software and wait for the installation program to open.  Select the language you prefer: 

 

(5) Read and accept the license agreement: 

Click on Install Software 

Select preferred language 
and click on OK 

https://signmaster.software/smc.htm
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(6) Enter the Product Serial Number which should have been sent to you by email when you purchased 
SignMaster. Note that since you will need this same number any time you update the software, keep it in a 
safe place: 

 
 

(7) Read and accept a second license agreement and then verify the destination for installing SignMaster: 

 

 

Enter the 20-digit PSN 
provided when you 
purchased SignMaster 
and click on Next 

Read the agreement, click 
on the accept option and 
click on Next 

Note where the program 
will be installed and click 
on Next 
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(8) Select your preferred Units but note that it can easily be switched once the software is open: 

 

(9) Select Skycut EV24 (or the model you have purchased) from the drop-down menu: 

 

(10) In the next window, you’ll have the option to create a desktop icon and install a thumbnail previewer. Both 
are recommended.  

 

Select preferred Units 
and click on Next 

Select Skycut EV24 and 
click on Next 

Select preferred options 
and click on Next 
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(11) At this point, files will be extracted and installed. Wait for the Installation Complete message and click on 
OK: 

 

(12) Then the final Finish message will appear and you can choose to open SignMaster or wait: 

 

• If you run into any issues installing or activating the program, please visit this link:  

http://www.iifuture.net/faq/index.php?action=show&cat=44 

• You may wish to periodically visit the link provided for SignMaster at the beginning of Section 2.1.1 to 
download and install any new updates.  

 
 

 

2.2 Connecting the Skycut to Your Computer      

• Place your Skycut on a sturdy horizontal surface. If using the cutting mat, be sure to allow enough free room 
in both the front and the back for the mat to extend during cutting. 

• Powering On:  

 Plug the power cord into a wall outlet or power strip. Connect the power cord to the Skycut on the left 
side end cap.  

 Turn on the power using the power button that is also on the left side end cap. After several seconds, 
the light inside the Skycut will turn on and the blade carriage will do a slight jog. 

• You have four options for sending files and information from your computer to the Skycut:  

 Direct USB using the included USB cable      

 Wi-Fi – adding the Skycut to a home/office network that is also accessed by your computer    

 Wireless Standalone – connecting wirelessly to your computer  

 UDISK - Exporting PLT files from SignMaster onto a USB flash drive and then loading those files using 

the control panel on the Skycut.   

Click on OK 

Click on Finish 

Leave checked if you wish to 
open SignMaster now 

http://www.iifuture.net/faq/index.php?action=show&cat=44
https://drive.google.com/file/d/1UxFUrBYBX58H3dPOmiACFzGtvnUWGNH8/view?usp=sharing
https://drive.google.com/file/d/1XPDIMJ5-oiW_Tgzc8S2xUGVE0CGemf-X/view?usp=sharing
https://drive.google.com/file/d/1nlBtvOxnWdWJy5Tn0QCrIsXkSReWNvI8/view?usp=sharing
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• Review the information in the following table to understand the differences between these options. Note that 
implementing any of these options does not preclude you from changing to another one, as needed. 

Connection Options for the Skycut

Option USB Wireless to Network (Wi-Fi) Wireless Stand-Alone UDISK (USB Flash Drive)

Description The Skycut is connected to the 

computer via a USB cable

The Skycut is wirelessly 

connected to a network router

The Skycut is wirelessly 

connected to the computer.

Files are saved in PLT format 

from design software to a USB 

flash drive

Requirements USB cable (included) Wireless network router and 

knowledge of router's name 

and password

Computer must have wireless 

capability

USB flash drive

Pros Easy to install; Reliable and fast 

form of communication.

Skycut can be located 

anywhere within range of the 

router; Other computers can cut 

to the Skycut

Skycut can be located 

anywhere within range of the 

computer; Other computers can 

cut to the Skycut

Skycut can be located 

anywhere 

Cons Skycut is physically connected 

to the computer; Cannot be 

accessed by other computers 

at the same time

Requires more steps to set up; 

Some routers may require 

setting changes in order to 

work with the Skycut

Computer is now connected to 

the Skycut, thus no wireless 

access to the Internet or to 

other wireless devices

More steps due to saving and 

then loading the file; Cannot 

adjust size and certain cut 

settings once saved
 

• The following sections present what steps are required for three of the connections. For Wireless Stand-
alone, which is not commonly used, refer to Appendix B.  If you run into connectivity issues with any of 
these options, please contact your dealer. 

 
 

2.2.1 USB Connection       

• Plug the small square end of the USB cable into the right end cap of the EV24. Plug the USB end into an 
available USB port on your computer. 

• In SignMaster, click on the Cut, Plot & Engrave Tools icon   (6th from the left on the upper middle 
task bar) and select Vinyl Spooler.  In the window which opens, click on the Connection tab. 

• Verify that Skycut EV24 (or the model you have purchased) is selected under Current Cutter. If not, select 
it from the drop-down menu. Under Port Type, select Direct USB Port. In the drop-down menu next to USB 
Port, select an option that contains the word “skycut”: 

 

Should read 
Skycut EV24 
(or the model 
you have 
purchased) 

Select Direct USB 
Port 

Look for and select an 
option with “skycut” in 
the name 

https://drive.google.com/file/d/1UxFUrBYBX58H3dPOmiACFzGtvnUWGNH8/view?usp=sharing
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• If a USB Port option cannot be located, verify the connection at both the cutter and on the computer. Once 
connected, click on Done at the bottom of the window. 

 

2.2.2 Connecting the EV24 to a Wi-Fi Network     

• For initial setup using the Wi-Fi option, you may need to place the cutter in the same room or in close 
proximity to the Wi-Fi router. This will create a stronger connection and faster Wi-Fi network configuration.  
Once the connection is set, you can move the cutter around within the limits of your router’s coverage area. 

• You will need the name of the network and the password. 

• On the control panel, press the MENU button, select WIFI, and press OK. The following screen appears, 
although initially yours will have more blank fields: 

 

• Work in order downwards, starting with SSID: 

(1)  Use the Y buttons to highlight SSID in blue. Then press OK and the EV24 will begin scanning for 

available networks. This may take a minute before a menu of networks appears. Select the network you 

wish to use (should match what your computer is using) and press OK.  

(2)  Use the Y- button to move down to PassWord and press OK.  A screen resembling a keyboard will 

appear. Use the X and Y buttons to move to appropriate keys in order to enter your network’s password, 

pressing the OK button to add a character to the display of your password.  Note that the AB key will 

toggle to upper case keys, if needed.  The button in the lower right will delete the last character showing. 

When your correct password appears in the display, move to the OK key, and press it.  

(3)  Use the Y- button to move down to IP Address. The first three sets of values will be obtained from your 

network but will continue to be displayed with the letter “x.” Use the X+ or X– buttons to set the last digits 

of the IP Address you wish to use. Press OK. 

(4)  Use the Y- button to move down to Apply and press OK. Wait a minute or two and the IP Address will 

then appear in the orange strip at the top of the display. Your EV24 is now a connected device on your 

network. 

 

 

 

 

 

 

 

 

 

1. Start with SSID  

3. Select IP Address 

2. Enter Password 

4. Click Apply 

Press OK to 
open additional 
screens 

https://drive.google.com/file/d/1XPDIMJ5-oiW_Tgzc8S2xUGVE0CGemf-X/view?usp=sharing
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(5)  Note the complete IP address at the top of the window. You will be entering this same IP address in the 

software you use for cutting. 

(6)  If you need to reset or change networks, move to the DEFAULT option and press OK. After a minute, 

this will reset the settings and enable you to change the network. 

(7)  Before connecting the EV24 to your computer using a Wi-Fi connection, you must verify that your 

computer is also connected to the same network.  To do this, locate and launch the network icon for 

your computer: 

 

 

   

                         

 
(8) A menu of available networks will appear. Select the network used for the EV24 setup and, if needed, 

enter the network password. Wait a bit for the connection to be made and the menu should indicate you 
are now connected to that network. 

(9) In SignMaster, click on the Cut, Plot & Engrave Tools icon   (6th from the left on the upper middle 
task bar) and select Vinyl Spooler.  In the window which opens, verify that Skycut EV24 is selected 
under Current Cutter. If not, select it from the drop-down menu. Under Port Type, select Windows 
Port. Mark the option for Port and select TCP from the drop-down menu: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note the  
IP Address 

Click on the Network icon. 
(usually in lower right corner) 

On a PC: 

Click on the Network icon. 
(usually in upper right corner) 

On a Mac: 
If you are connected via 

Ethernet, your network icon 
may look like this. 
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(10)  Click on Configure and the following window opens: 

 

(11)  Change the IP Address to the one you set up on the Skycut control panel. Click on Test. A Port OK 
message should pop up. If the test fails, confirm the IP Address you entered and try again. Additional 
troubleshooting for Wi-Fi connections can be found in Appendix A1. 

(12) Once Port OK is displayed, click on OK and then click on Apply. 

                         

 

(13)  The IP Address should now appear in the Vinyl Spooler window: 

 

 

Should read 
Skycut EV24 
(or the model 
you have 

purchased) 

Select Windows 
Port 

Click on 
Configure 

Select Port 

Select TCP 

Default IP Address 

Click OK Click on Apply 

Click on 
Test Change to IP 

Address from 
control panel 
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(14)  Click on Done.  
 
 

2.2.3 USB Flash Drive         

• With a USB Flash Drive connection, you will normally follow the steps presented in this section. If you are 
new to SignMaster and/or to your Skycut, it is recommended that you go to Section 2.3 now to learn how to 
insert the mat and test pen, adjust settings on the control panel, and set up a test design. Then, when you 
are ready to cut, return to this section.   

• Design or open a file in SignMaster. After making any changes to the design, click on the Cut, Plot & 

Engrave Tools icon   (6th from the left on the upper middle task bar) and select Send to Cutter. The 
following window opens: 

 

 

• Click on the Properties button to open the Vinyl Spooler window. The Cut Options tab should 
automatically be selected. Verify that the Pen Tool is selected (assuming this is your first time testing your 
Skycut).  Also verify that the force and speed settings are not marked. At the current time, it is 
recommended that you always do these settings on the Skycut’s control panel, instead: 

Preview of 
where shape 
will be drawn 
or cut 

Click on Properties to open Vinyl Spooler window 

 IP Address should 
now be here 

Click on Done 

https://drive.google.com/file/d/1nlBtvOxnWdWJy5Tn0QCrIsXkSReWNvI8/view?usp=sharing
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• IMPORTANT: For initial testing of your Skycut, it is highly recommended that the test pen be used until you 
know, with certainty, where shapes will draw.  

• Click on the Connection tab and verify that Skycut D24 is selected under Current Cutter. If not, select it 
from the drop-down menu. Under Port Type, select Windows Port. Mark the option for Port and then 
select U_Disk from the drop-down menu: 

   

 

Uncheck all 
three of these 
settings 

Pen drawing: select Pen Tool 
Cutting: select blade type from 
menu  

Pen drawing: 
leave unchecked; 
Cutting: Check 
and enter settings 

Click on Done 

Select Cut 
Options tab 

 

Should read Skycut 
EV24 (or the model you 
have purchased) 

Select Windows 
Port 

Select Port Select U_Disk 

Select Connection tab 
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• Click on Done at the bottom of the Vinyl Spooler window and you will be returned to the Send to be Cut 
window. More about the settings on the left side of the window will be covered in Section 3.3. For now, just 
note where your shape will draw relative to the material and how to initiate the exporting of the PLT file: 

   

• Insert a USB flash drive into your computer and allow Windows to find it. Note the drive letter assigned by 
Windows. 

• Click on Cut Now and a Save PLT File window opens because earlier you had changed the connection 
type to U_Disk. Browse to locate the USB flash drive you plan to use and name your PLT file: 

 

 

• Once the file is saved, eject the flash drive from your computer. Proceed to the next section. 
 
 

2.2.4 Loading and Cutting a .PLT File from the USB Drive 

• Insert the flash drive into the right endcap of the Skycut.  

• On the control panel, press the FS button and change the FORCE and SPEED settings if you did not elect 
to send them within the .PLT file (refer to Section 3.3.1). Perform a test cut, if needed. 

Note where the 
design will draw 
relative to where the 
test pen is positioned 

Click on Cut Now 

This figure assumes 
blade holder is positioned 
in the lower right corner of 
the material 

Locate the USB flash 
drive for saving your files 

Enter a file name 

Click on Save 
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• IMPORTANT: Once the PLT file has been selected, cutting will begin immediately!  Thus, make sure the 
media is inserted and aligned in the cutter, the pinch wheels are down, and the blade is positioned at the 
desired location for the origin.   

• Press the UDISK button on the control panel. The EV24 will browse the contents of the installed USB thumb 
drive and display all readable .PLT files.  Note that if there are folders on the drive, highlight the folder and 
press the OK button to display that folder’s contents. Use the X- button to exit from a folder.  

• Once you have the desired PLT file highlighted, press OK to begin the cut: 

 
 

2.3 Test Draw Shapes 

• New owners tend to be VERY eager to try out their Skycut. It’s important to test your cutter to ensure that 
data is being sent properly from your computer to the cutter. The following sections will allow you to do 
some testing with the pen tool. But note that the following steps are for DRAWING, not cutting.  Before 
inserting the blade holder into your cutter, please read the following Sections 1.7.4, 1.7.5, 3.1, 3.2, and 3.3. 

 
 

2.3.1 Setting up the EV24 for Test Drawing 

• Besides testing the communication, it is also very important to understand where shapes will cut based on 
various available options in the software. This is partially addressed in the next few sections; complete 
details are covered in Section 3.2.2. 

• Before setting up a file for testing, if you are new to the software, watch an introductory video to become 

familiar with the basics.                                                  

• You have two options when using the test pen:  

 Insert a sheet of paper directly into the cutter. Make sure the paper is past the ruler so that it doesn’t 
catch when feeding the paper forward: 

 

 Or…Place the paper onto the cutting mat and then insert the cutting mat into the cutter:  

 

 

Observe how pinch 
wheels are centered 
with white rectangles 

 

Observe how pinch 
wheels are centered 
with white rectangles 

 

http://iifuture.org/vmtuts/getVMTut.php?key=smc_full_introduction&r=0
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• Use any of the horizontal markings at the front of the Skycut (such as the ruler) to align the mat so that it’s 
straight. Lower the pinch wheels in the back. Most of the mat and the paper should now be behind the 
cutter, not in the front. 

• Before installing the test pen, make sure the pen will write by scribbling on scrap paper. Note that you will 
probably need to remove a tiny bit of wax on the end of the pen nib. Then follow these steps: 

 Loosen the screw on the blade holder seat. 

 Insert the test pen allowing it to freely rest on top of the paper.  

 Before tightening the front screw, raise the test pen up a little bit (~ 1/8” or several mm).  You don’t want 
the pen still touching the paper but you also don’t want the pen too high above the paper either. 

 Tighten the front screw to lock in the test pen. Be careful not to push down on the blade holder seat 
while tightening.  

 

 

• The arrow keys on the Skycut’s control panel will always be used to set the origin for cutting: 

 

 Click on the buttons or the arrow keys on your keyboard to move the head left or right and the mat in 
and out. The goal is to have the tip of the pen close to the lower right corner of the paper: 

 

Only the front part of the 
mat and material will be 
in the front of the 
machine. 

 

Feed the mat this 
direction into the 
Skycut 

Align the paper along 
one of the grid lines on 
the cutting mat. 

Use the Y+ and Y- buttons to move 
the mat or material in and out  
 
 
Use the X+ and X- buttons to move 
the blade carriage left and right 

IMPORTANT!  This is NOT the recommended method for loading the blade holder into the cutter. 
This is presented as a quick way to insert the test pen so that it is in a good position for drawing. 
The instructions for inserting the blade holder are covered in Section 2.1.3. 
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 Once the pen tip is near the lower right corner, you are ready to proceed with the test. 

 

2.3.2 Test Drawing 

• In SignMaster, on the left side tool panel, press and hold the General Power Shapes icon and, from the 
drop-down menu, select the Arrow option:  

 

• Press and hold the left mouse button and drag the mouse in the Drawing Area to create the arrow shape. 
In this test, it doesn’t matter where you place the arrow on SignMaster’s Drawing Area, as it will be drawn 
at the origin you set on the machine.  

  

• If you wish to resize the arrow, either drag one of the square handles around the selected arrow or, in the 
settings above the Drawing Area, change the Width or Height, if desired: 

 

• At this point, if you plan to export this file to a USB flash drive, rather than cut directly to the Skycut from 
SignMaster, please go to Section 2.2.3 for instructions.  

• After making any changes to the design, click on the Cut, Plot & Engrave Tools icon  and select 
Send to Cutter. The following window opens. More about the settings on the left side of the window will be 
covered in Section 3.3. For now, just note where the shape will cut relative to the material: 

Press and hold the 
General Power Shapes 
icon 

 

Select Arrow 

 

Move pen tip 
to this corner 
of the paper 

Move the pen tip 
to this corner of 
the paper 

Feed the mat or 
material this direction 
into the Skycut 

Width and Height 
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• Before executing the cut/draw process, the Pen tool will be selected. Click on the Cutter Control tab and 
the following settings will be displayed: 

 

 

• Click on the small icon to left of Passes and the Blade Settings Library opens: 

 

• To switch to the test pen, click the down arrow to the right of Description and select Pen Tool: 

 

 

Note where design 
will cut relative to 
where the blade 
holder is positioned 

Test pen is positioned in 
the lower right corner of 
the material before 
drawing 

Open Blade Settings Library 

Tool settings 

Click on the Cutter Control tab 

Click down arrow 
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• Click on Apply and the Cutter Settings (Tool settings) will update showing a 0.00 setting for Blade Offset 
(more about this setting is covered in Section 3.3.3): 

 

• Click on Cut Now and the Skycut will draw the arrow on your paper: 
 

                

• To draw again, return to the cut window and choose a different origin. Practice moving the origin to different 
locations. If you want to have the arrow draw in a Landscape orientation, then mark the Rotate option. You 
will see the arrow rotate in the Preview: 

 

 

 

 

 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn at the origin 
and points to the right.  

 

Select Pen Tool A test pen image appears 

Pen Tool now 
appears here 

Pen Tool should now appear here 

Blade Offset should now read 0.00 
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• Cutting with this setting results in the arrow pointing downwards as shown in the prior preview window: 

 

• If you want the arrow to draw where you have it located on the Drawing Area in SignMaster’s main screen, 
versus at the origin, then you need to mark the option called Absolute (position) in the same Send to be 
Cut window: 

  

 

 

Check Rotate 

Note arrow is 
now rotated 
 

Feed the mat this 
direction into the 
Skycut 

The arrow is drawn at the origin 
and points down  

 

Location of arrow in 
Drawing Area  
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• Set the origin in the lower right corner of the mat’s grid and then place the paper in the correct location on 
the mat to correspond to where the shape is positioned in SignMaster.   Refer to Section 3.2.2 for more 
details on controlling where images will cut. 

 
 
 
 
 
 
 

  

IMPORTANT:  Please read Section 3.1 before cutting! 

Check Absolute (position) 
Arrow will now draw 
in this location 
 

Test pen is still positioned in lower right 
corner of material before drawing 
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3. Cutting 
 
 
 

3.0 Quick Reference for this Chapter 

• How to properly mount the blade holder: Section 3.1.3 

• How to control which shapes get cut: Section 3.2.1 

• How to control where shapes get cut: Section 3.2.2 

• Understanding Blade Offset and Overcut: Section 3.3.3 and Section 3.3.4 

• How to add weeding lines to a cut: Section 3.6.2 

• Checklist before cutting: Section 3.7 

• How to get shapes to cut to precise dimensions: Section 3.8 

• How to know which settings to adjust to solve cutting issues: Section 3.9 

 

The Most Common New Owner Mistakes: 

• Too much blade is exposed on the blade holder (material is lifting up and/or tearing) - refer back to Section 
1.7.4 

• The blade holder or test pen haven’t been properly mounted - refer to Section 3.1.3 

• The pinch wheels are not properly positioned (material or mat is sliding around or bunching up during the 
cut) – refer back to Section 1.8 

• Failing to do a test cut (recommended cut settings are not working) – refer to Section 3.1.5 and 3.9 

• Not practicing enough with the test pen and paper (shapes are not cutting in the correct locations) – refer to 
Section 3.2.2 

 
 

3.1 What You Need to Understand About Cutting 
 

3.1.1 You Have To Make Mistakes 

• To be a successful owner of a Skycut, you need to keep in mind a few factors: 

 The key to becoming successful at cutting is to do a lot of it.  

 You’re going to make mistakes.  This is normal and part of the process of mastering a cutter. 

 Read all of Sections 3.1 and 3.2.  

 Perform test cuts before cutting large projects. It prevents wasted material and preserves your valuable 
time. 

 
 

3.1.2 Record Your Successes 

• As you have successful cuts, take note of the settings you just used, such as Force, Speed, blade type, 
number of passes, brand of material, etc. There is a blank form in Section 3.10 that you can print and use to 
record your results.  There are also suggested settings for common materials at the end of this chapter. Use 
these as starting guides but remember that your results may vary based on the many factors which can 
affect cutting. 

 

IMPORTANT:  Please read all of 3.1!!! 
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3.1.3 Installing the Blade Holder, Test Pen, or Accessory Tools    

• The gold blade holder has a rim around the outside that will, when cutting most materials, rest on the lower 
part of the blade holder seat.  When inserting the blade holder, loosen the front screw and the clamp should 
then move back a bit to permit the blade holder to drop down:   

 

• The Blade Height is the distance from the tip of the blade to the top of the material you are about to cut. 
Thus, in the photo above, you can see that there are several millimeters of Blade Height which is important 
for two reasons: 

 You do not want the blade dragging across the material when the blade holder is moving from the origin 
to the first shape to cut (or between shapes). 

 More force is applied when there is a drop distance for the blade holder to start cutting. This is also 
referred to as “punch room” and provides more consistent cutting across the width of the machine.  

• When using the test pen or an accessory tool without a rim, you’ll need to insert the tool using a spacer on 
top of the material.  A stack of 35 Post-It notes or 35 sheets of regular copy paper work well.   

 The recommended method for loading the test pen or another accessory: 

o Place the spacer on top of the material, with the material loaded into the Skycut.  

o Loosen the screw on the blade holder seat and insert the tool so that the tip of the tool is touching 
the top of the spacer: 

 

o Now tighten the front screw carefully making sure you are NOT pushing down on the blade holder 
seat. Once tight, remove the spacer.  You should feel the tool gently scratching the top of the 
spacer. 

o This distance will provide the tool some “punch room” to give extra force and more consistent 
results.    

 
 

3.1.4 Adjust the Speed, Force, and Number of Passes Based on the Material and Shapes 

• Using correct cut settings is equally important as the type of blade, blade length, and blade height. Refer to 
Section 3.3 for details about each setting.  

 
 

Pen tip just touches top 
of spacer 
 

Spacer is on top of material 
which is on top of mat 
 

The outer rim on the blade 
holder is resting on the lower 
part of the blade holder seat 
 

With the front screw loose, the 
black clamp can be moved back 
just a bit to allow the blade holder 
to drop down. 
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3.1.5 Perform Test Cuts! 

• You have two options: 

(1) Perform the built-in test cut on the Skycut itself using the TEST button on the control panel. 

(2) Select any basic shape and size it to be around 0.3” – 0.5” (~ 8 mm – 13 mm): 

o I personally like using a design with an internal shape, such as a ring. You can then easily see if the 
blade is cutting into the mat (or into the backing sheet on rolled materials) when you lift out the cut 
shape and observe where the internal shape cut. To locate a ring, click on the General Power 

Shapes icon  on the left side Tool Panel and go to Basic Shapes>Basic.  

o When cutting intricate shapes, use a small letter or a shape will lots of sharp turns for testing. For a 
rhinestone project, use a small portion of your rhinestone pattern as a test. 

• There is a flow chart in Section 3.9 which will help you determine which settings to change when test cutting 
a material.  

 

3.1.6 Keep the Cutting Mat Clean and Sticky 

• Press your materials evenly to the mat.  Consider using a brayer both before AND after cutting. Repressing 
the material after cutting can greatly aid in weeding the cut shapes from the waste. 

• When necessary, tape thicker materials to the mat to keep them from slipping during the cut.  

• If you cut a range of materials, you might need more than one mat so that you can use stickier mats for 
certain materials. 

• Refer back to Section 1.7.5 for information on cleaning the cutting mat and adding more adhesive. 
 
 

3.1.7 Don’t Get Frustrated, Get Help! 

• Besides having your own Skycut dealer as your first line of contact, there are other resources where you 
can ask questions and get answers. Utilize the resources listed in Section 1.1. 

 
 
 

3.2 Choices Before Cutting 

• There are a number of factors under your control for cutting: 

 What shapes to send to the cutter: Section 3.2.1 

 Where the shapes will be cut from the material: Section 3.2.2 

 What tool(s) will be used for cutting (or drawing, scoring, engraving, etc.): Section 3.2.3 

 What settings will be used: Section 3.2.4 
 
 

3.2.1 Controlling Which Shapes Will Cut 

• There are three ways to control whether a shape will be cut or ignored. In explaining these options, the 
following shapes have been added to the Drawing Area. Note that this file (called Controlling What Cuts) is 
shared in a zip file available here.  

https://drive.google.com/file/d/1cECETKrdKePCkAEXB46EYMF5xmuhiw1G/view
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 Option 1: If no shapes are pre-selected, then all shapes will be sent to cut. However, if you pre-select, 
for example, only the “Skycut” and the arrow, then only those shapes will appear in the Send to be Cut 
Preview: 

        

o A more common practice is to select all objects of one color and only have those shapes sent to cut. 
To do this, go to Edit>Select by>Color (or use the shortcut key “S”) and the following window will 
open where you can, for example, mark Red to be selected. Then the Preview will only have 
“Skycut”, the red circle, and the red star present: 

       

o Along the same lines, you can select all objects of type and only have those shapes sent to cut. To 
do this, go to Edit>Select by>Object Type (or use the shortcut key “O”) and the following window 
will open where you can, for example, mark Circle and Star. Then the Preview will only have 
circles and the stars present: 

 

 

These two 
shapes are 
selected Only those two 

shapes appear in 
Preview 

Mark the box 
by Red 

Only the red 
shapes appear in 
Preview 

It’s also noted here that 
only red shapes are 
selected 

Click on OK 
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o Note that the icon at the top of the screen:  will open a menu where you can then access the 
same Select by Color or Select by Type options: 

 

 Option 2: Mark shapes not to be cut on the Objects tab of the Page Thumbnail Viewer:  

o To access the Objects tab, click on the small icon to the left of the palette: 

`      

 

o Select a shape, such as the arrow. On the Object tab, it can then be set not to cut: 

Click this blue 
arrow 

Click the Objects tab 

All of the shapes 
appear in a list 

Mark boxes for 
circles and stars 

Only the circles and stars 
appear in Preview 

Click on OK 

Click on the Select by icon 



 38 

 

 

 

                            

 

 

 

 Option 3: Cutting can be controlled by color from within the Send to be Cut window. Click on the 
Separate by Color option and a drop-down menu will appear: 

  
 

o In the Preview window, shapes with the current color from the menu appear. Also, the color is 
selected at the top: 

 

 

 

 

 

Arrow is 
selected 

Arrow will not cut Click this icon to 
turn off cutting 

Arrow is no longer in Preview 

Drop-down menu 
of colors used in 
the project 

Mark the 
Separate by 
Color option 
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o Switching to blue changes the window accordingly: 

  

o Note that you can also change colors by clicking on those colored rectangles above the preview. 

 

 Option 4: Select the colors in the Vinyl Spooler window.  

o In the Send to be Cut window, again click on the Separate by Color option. Then, click on Spool 
All:   

 

Black is selected 
in the drop-down 
menu 

  Black is outlined here 

The one black 
object is the only 
shape shown in 
the Preview 

Blue is selected 
in the drop-down 
menu 

  Blue is now outlined 

The two blue objects 
now appear in the 
Preview 
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o In the Vinyl Spooler window, the job will appear at the top and queueing of each color will begin. In 
this example, Red is at the top of the menu and the red shapes appear in the Preview. Click on Cut 
Now to cut those shapes. Otherwise, click on either Blue or Black: 

  
 
 
 

o After the red shapes are cut, it will no longer be in the menu. The next color (Blue) will be selected 
and you can again choose to cut that color or select the third color (Green):  

 

Click on Spool All 

Enable Separate 
by Color 

Red is queued up 
to cut first. Either 

cut the red shapes 
or select another 

color. 

Click on Cut Now to 
proceed with cutting 
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o After the last color is completed, the job is moved to the Done folder and can be repeated at any 
time: 

 
 
 

 

3.2.2 Controlling Where Shapes Will Cut 

• This was briefly covered in Section 2.3.2 where the Rotate and the Absolute (position) options were 
introduced.  

 Default: Moves the shapes to align with the origin you have set based on the blade tip. 

 Absolute (position): Cuts the shapes where they are positioned on the Drawing Area.  

• You can also rotate a design for cutting, relative to how it appears on the Drawing Area: 

 To rotate the project, go to Send to be Cut and mark the Rotate option: 

 

 

 

Blue is queued for 
cutting. Or select 
Black, if desired. 
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 For example, in a project with long text, it is more convenient to view and edit the text in a left-to-right 
orientation: 

 

 However, when you then send this project to the Preview window, you will observe that it is too wide to 
cut from left to right on your Skycut: 

         

 Marking the option for Rotate will then rotate the design and allow the project to cut: 

The red lines and dimensions 
also indicate the project 
cannot be cut 

Project is too wide to 
cut left-to-right 
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3.2.3 Selecting the Tool to be Used for Cutting 

• To select the tool you’ll be using, open the Send to be Cut window, select the Cutter Control tab, and click 
on the Open Blade Settings Library icon:   

 

• The Blade Settings Library window will open. Click on the down arrow to the right of Description where 
you can access a drop-down menu for the Blade Type: 

 

         

The black lines and dimensions 
indicate the project can now be cut 

Rotated project will now fit 
within the width of the machine 

Click on this icon 

Click here 

Tool menu 
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• Select one of the options, such as 45 degree blade, and an image of the blade, its Blade Offset and 
Overcut settings will be displayed. These settings are assigned as a Preset: 

   

• Sections 3.3.3 and 3.3.4 will explain Blade Offset and Overcut settings. Section 3.4 will explain how to 
modify these settings, if needed and save as a Preset. 

       

3.2.4 Determining the Cut Settings  

• There are three locations in SignMaster where Cut Settings can be selected: 

 Send to be Cut>Cutter Control tab (which was covered in Section 2.3) 

 Send to be Cut>General tab (with Assign Tools by Color enabled) 

 Vinyl Spooler>Cut Options tab  

• Send to be Cut>General 

 Use this location when you need to assign different settings to different layers of your project. For 
example, let’s say you wanted to use the embossing tool to score lines in a popup card, followed by 
cutting out the card itself. Or, another example would be using the test pen to draw a design and then 
cutting a contour around it. Under General Options, Assign Tools by Color is marked and then, below 
that in the Cutting Tool Presets section, individual colors can be highlighted and cut settings assigned 
by selecting a Preset or by clicking on Edit: 

 

• Vinyl Spooler>Cut Options 

Color of cap on a 
Skycut 45° blade 

Presets for Blade Offset 
and Overcut 

Mark Assign Tools by Color 

A color is selected 

A Preset is selected or settings 
can be entered by clicking on Edit 



 45 

 Use this option as an alternative to entering settings via the Cutter Control tab. It can be accessed from 
the Properties button in the Send to be Cut window: 

  

 In the Vinyl Spooler window, click on the Cut Options tab and the cut settings are located in the lower 
section of that window: 

  

• These settings should be understood thoroughly, as you will be adjusting them often as you change 
materials or as your blade dulls over time. Note the prior screenshot shows the section number to go to for 
more information. 

 
 
 

3.3 Cut Settings 

• Before presenting the various settings, note that the Force and Speed settings can be set on the control 
panel itself. In order to cut from SignMaster and use the settings on the Skycut, uncheck these boxes in 
either of the two places where the settings can be made: 

 Send to be Cut>Cutter Control window: 

 

 Vinyl Spooler>Cut Options window: 

 

Section 3.3.2 

Section 3.3.4 

Section 3.3.3  

Section 3.3.1 

Uncheck these boxes if Speed and 
Force settings on Skycut are to be used 

Click Properties to open 
Vinyl Spooler window 
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3.3.1 Force 

• Force (also called Pressure) ranges from 30 to 160 where the maximum of 160 represents ~2000g of 
cutting force. If it is set too low, the material cannot be cut. In fact, it is recommended that the minimum 
setting is always 30 or higher.  However, if it is set too high, you will get bad cutting (even incomplete cutting 
at times) and tearing of the material. Always perform small test cuts before cutting your actual project and 
make adjustments in order to get a clean test cut before proceeding with your larger cut. 

• Dull blades will need more force than new blades, thus anticipate increasing the force over the life of the 
blade. 

• When cutting materials that can use either blade, the 45o blade (red cap) will need a little more force than 
the 60o blade (blue cap), because of the extra contact with the material being cut. 

• As noted earlier, Force can be set on the Skycut control panel instead. Press the FS button and then set the 
FORCE to the desired level using the Y+ and Y- buttons. Conclude by pressing OK or the FS button again: 

 
 
 
 
 
 

3.3.2 Cut Speed and Up Speed 

• Cut Speed (also called Down Speed) is how fast the blade travels while it is in the “down” or cutting 
position. Up Speed (also called Travel Speed) is how fast the blade travels while in the “up” position, such 
as when it is moving from the origin to the location of the first shape to cut or when moving from one cut 
shape to begin cutting another.  

• The Skycut has 13 speed settings ranging from “snail’s pace slow” to “insanely fast.”  

 The settings from 1 through 4 are the slow speeds and should be used when cutting dense difficult 
materials, such as chipboard, craft plastic, styrene, and balsa. 

 The settings from 5 through 8 are medium speeds and should be used for easy-to-cut materials, such 
as cardstock, vinyl, iron-on transfer, and rhinestone template material. 

 The settings from 9 through 12 are the fast speeds and are useful for engraving, embossing, and 
drawing.  You may, however, find that some materials will cut well at the faster speeds. 

Uncheck these boxes if Speed and 
Force settings on Skycut are to be used 

X- / X+: change SPEED 
Y- / Y+ change FORCE 

OK return to normal mode  

Press TEST to cut a 
small square 

Press FS to highlight 
SPEED and FORCE 
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• Cut Speed is usually more important to control since the blade may need more contact time with a 
particular material. Up Speed can usually be left quite high.  

• On the Skycut control panel, there is only a single speed setting, thus the Up Speed and Cut Speed are the 
same and referred to as SPEED. This can be adjusted by pressing the FS button and then using the X- and 
X+ buttons alter the SPEED to the desired level.  Then press the either the OK button or the FS button 
again. 

 
 

3.3.3 Blade Offset 

• Blade Offset is the horizontal distance from the center of the blade shaft to the tip of the blade.  A pen or 
engraving tool has an offset of 0 because the tip is centered with the center of the pen/engraving tool shaft. 
But a blade is different: 

 
  

 
  
 
 
 
 

• If you set the Blade Offset to 0 when cutting with a blade, corners will be rounded. On the other hand, if it is 
set too high, bubbles will be cut on sharp corners: 

  
 
 

 
 
  
 
 
 

• Currently it is recommended that a Blade Offset of between 0.25 – 0.35 be used for each of the three types 
of Skycut blades.  Any time you order new blades, check for the recommended Blade Offset on the 
packaging.  However, it’s not unusual for blades to be slightly off-spec. Based on cutting a rectangle or 
square, increase or decrease the Blade Offset in increments of 0.1 or smaller until the shape has perfectly 
square corners.  

• Alternatively, SignMaster has two built-in Blade Offset calibration routines which can be used to determine 
the best Blade Offset setting for the current blade in use. Here are the steps to access either one: 

 Select the material you want to use for testing, such as vinyl, paper, or cardstock. Note how much 
material will be needed for the test you select and add a few inches to these dimensions: 

o Normal Test: Width: ~9” (354 mm)   Height: ~3.5” (89 mm) 

o Quick Test: Width: ~4.5” (114 mm)   Height: ~1” (25 mm) 

 Install the blade you wish to calibrate into the blade holder and mount the blade holder in the Skycut. 
Enter appropriate settings in SignMaster or on the Skycut control panel. Test cut a small shape to make 
sure the settings are correct.  

 Go to the Vinyl Spooler window, click the Calibrations tab, and select Show Calibration Tools. 

 Click on the Blade Offset icon and a new window opens: 

 

 

 

Offset is too low: 
corners are rounded 

Offset is too high: bubbles 
appear at the corners 

Imagine a line 
passing through 
the center of the 
test pen or 
blade 

The Offset is the distance 
between the center of the 
blade holder and the tip of the 
blade. 

There is no 
Offset on a 
pen. 
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 In both tests, the instructions on the screen will guide you on how to enter the best result and then will 
display the recommended Blade Offset to use. This new Blade Offset value will then be updated in the 
cut settings. Instructions on how to add this setting as a Preset are covered in Section 3.4. 

 
 

3.3.4 Overcut 

• Overcut is related to Blade Offset in that it isn’t needed when using a pen, embosser, engraver, and so 
forth, because the tips of those tools are aligned with the center of the tools themselves. However, leaving 
Overcut at 0 when using the blade holder will result in large shapes not quite closing: 

  
 
 
 
                             
                       

• In some cutting programs, Overcut is not a separate setting but rather automatically calculated and applied 
based on the Blade Offset entered. However, in SignMaster, you can enter an actual Overcut setting and 
should do so any time a blade is used.   

• In general, the blade type doesn’t greatly affect the Overcut required. Try using 1.00 mm. In the event you 
cut a large closed shape, like an 8” circle, you may find that you’ll need to increase Overcut to 2.00 mm.  

 
 

3.3.5 Passes 

• The Passes setting causes each individual path to be cut the set number of passes before the blade moves 
to the next path to cut. This is better than just repeating the entire cut as each repeated pass is cut with the 
blade held down throughout the repeated passes, resulting in cleaner cutting. 

• In general, when increasing Passes, the Force setting can be decreased. For example, you may find a 
cardstock that requires a Force of 55 to cut in a single pass will only need a Force of 45 if cutting in two 
passes. 

• Passes is recommended in the following situations: 

 Cutting thicker denser materials, such as chipboard, where multiple passes allow the blade to 
progressively “carve” through the material 

 Cutting certain fibrous materials, such as fabric, where a second pass will ensure that all of the fibers 
have been cleanly cut 

 Cutting intricate or detailed shapes (such as script titles) from certain materials, such as heavy or 
textured cardstock, where a single pass may leave certain spots not cleanly cut 

Overcut is too low: 
paths do not close 

1. Select 
Calibration tab 

4. After loading material and 
verifying cut settings on the 
Skycut, click here.  

3. Select either Normal Test 
or Quick Test (note material 
requirements below) 

2. Click on Blade 
Offset icon 
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 Cutting rhinestone template material where a second pass results in much cleaner weeding of the cut 
circles 

• There are two different methods for setting Passes, depending on if you’re doing a regular cut or if you are 
utilizing Assign Tools by Color. 

 Regular Cutting (Assign Tools by Color is not activated) 

o You will find a Passes setting in the Send to be Cut window, under the Cutter Control tab: 

 

 

 Using Assign Tools by Color 

o As noted in Section 3.2.4, Assign Tools by Color allows you to enter different settings based on 
the color of the shape to be cut.  

o Select a color and click on Edit: 

 

o The following window opens where Multi-cut can be enabled and the desired number of Passes 
entered:  

Change Passes here 

Mark Assign Tools by Color 

Select a color 

Click on Edit 
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3.4 Presets 

• Presets allow you to save your settings for a particular blade type or material.  

3.4.1 Saving a Preset for a Blade Type 

• Let’s say you conducted the calibration for Blade Offset in Section 3.3.3 and determined it to be 0.40 for 
your red capped blade. To save this setting as a preset, use the following steps: 

 Go to the Send to be Cut>Cutter Control window and click on the icon to the right of Blade Offset to 
open the Blade Settings Library:  

 

 

 In the Blade Settings Library, click on the + icon to the right of Description and a window will open 
where you can enter the name for your new preset: 

 

Open Blade Settings Library Click on the Cutter Control tab 

1. Enable Multi-
cut 

Set Quantity (number 
of Passes) 

3. Click Apply 
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 Click on OK and then select which blade type you are using for this new preset Enter the new Blade 
Offset and Overcut values. Then click Update: 

  

 Click on Apply to close the Blade Settings Library. The new preset will now be available for selection 
in the Description menu.  

• If you need to delete a preset, select it from the Description menu and click on the “-“ icon to the right. 
 
 

3.4.2 Saving a Preset for a Material 

• SignMaster allows you to save settings with a custom name for quicker access in the future.  

• Go to the Vinyl Spooler window, click on the Cut Options tab, and click on Edit Presets:  

 

• The following window opens where you can enter the settings, click the + icon, and name the Preset : 

3. Click on Update 

2. Enter new Blade Offset 
and Overcut values 

1. Select type of blade 

4. Click on Apply 

Enter a new name Click on + 

Click on Cut 
Options 

Click on Edit Presets  
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• The new Preset will appear under Preset Mode with the saved settings displayed. Click on Done to close 
the Vinyl Spooler window or Edit Presets if you wish to add more at this time.  

 
 

 

 

 

1. Enter all 
desired settings 

2.Click the + icon 

3.Enter a name 4.Click on OK 

Newly added 
Preset 

Preset settings 
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3.5 Setting the Origin before Cutting 

• Setting an origin is an important part of managing your material cost and controlling where your project will 
cut. Setting the origin consists of using the X and Y buttons to move the blade tip to a specific point on the 
cutter’s X axis (left-to-right on the platen) and advance the media forwards or backwards. 

• Once you have positioned the blade in a specific point over the media (typically close to the bottom right 
corner of the material), your origin is defined and you do not need to press anything before cutting.  

• IMPORTANT! The Skycut EV24 has a maximum cutting width of 24 inches. If you move the head too far to 
the left to begin the cut and your project is wide, you may exceed the left side limit and cutting will stop at 
that point with no option but to abort.  

 
 
 

3.6 Other Cut Setting Functions  

• There are other functions and features available in the Send to be Cut window that may be useful 
depending on your application. Some have already been covered. Some will be covered in this section. 
Others will be covered in later parts of this manual. Note the section numbers for reference: 

 
 

 The Advance After Plot function is performed on the Skycut’s control panel. Refer to Section 1.9.1. 
 
 

3.6.1 Mirror 

• Checking the Mirror option will apply a horizontal mirror to the shape (s) before cutting. This is useful in 
applications such as: 

 Cutting HTV in which the material is placed faced down so that the heat protection layer is not 
penetrated by the blade 

 Cutting vinyl to be applied to the inside of a car or home window but primarily viewed from outside of the 
window 

 Cutting certain non-homogenous paper materials in which cutting upside down yields cleaner results 

Not applicable (see below) 

Section 3.2.2 

Section 3.2.1 Option 3 

Section 3.6.2 

Section 3.2.2 

Section 3.6.2 

Section 3.6.2 

Section 3.6.3 

Section 3.6.2 

Section 3.6.1 
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3.6.2 Weeding Options 

• For those cutting vinyl and HTV, the weeding options in SignMaster are worth noting. 

 Auto Weed-Box: Marking this option places a single weed box around the entire project: 

   

 

 

 

o Note: to change the size/offset of the weed box around the design, click on the Settings tab and 
adjust, as desired: 

 

 

 

 

 Auto Speed-Weed: Marking this option places a single weed box around the entire project with an 
additional horizontal weed line through the middle: 

 

Before applying Mirror After applying Mirror 

Before applying Auto Weed-Box After applying Auto Weed-Box – blue 
border around design indicates weed cut 

Change offset here 

Click Settings tab 
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 Easy-Lift Weed Marks: Marking this option adds hooked lines to shapes with internal paths to make it 
easier to lift with a weeding tool: 

   

 

 
 
 

 Speed-Weed Text Only: Mark this option when your design has a combination of both text and other 
shapes so that only the text will have Speed Weed applied: 

    

 

 
 
 

3.6.3 Weld Text 

• For script fonts, the Weld Text option will remove overlap between letters so that a word will cut as one 
object. For example, if you go to View>Wireframe, you can see the overlap that will be cut when a script 
font is used: 

Before applying Auto Speed-Weed After applying Auto Speed-Weed – blue weed 
box plus horizonal weed cut in the middle 

Before applying Easy-Lift Weed Marks After applying Easy-Lift Weed Marks – 
hooked cuts are added to internal shapes for 
easy lifting during the weeding process 

Before applying Speed-Weed Text Only After applying Speed-Weed Text Only – 
text object has additional weed box plus 
horizontal cut through the middle 
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• You have the option to select the letters and apply the Weld function under the Shaping and Welding 

Tools , thus removing overlap between letters: 

 

• This, however, means you cannot change the font used or alter the spacing of the letters, etc., without 
applying Undo. Therefore, the Weld Text option allows you to cut the text as if the Weld function has been 
applied: 

   

 

 

 
 

3.7 Important Checklist Before You Cut! 

• Do you have your material on the mat and the mat inserted into the Skycut?  (Note: materials with a backing 
sheet, such as vinyl and iron-on transfer do not require a mat for cutting) 

• Have you selected pinch wheels positions that are roughly the same distance from the outside edges of the 
cutting mat (or material, if not using the mat)? 

• Are the pinch wheels in use centered over grit shafts (located below the white rectangle labels)? 

• Have you set the blade length/exposure based on the thickness of the material you are cutting? 

• Do you have the blade holder firmly mounted in the blade holder seat? 

• Have you set the Origin (location of the blade tip) at the bottom right corner of your material (or wherever 
you need the origin to be)? 

• Have you set the Force?    And the Speed?  Do you need to do a test cut? 

• Have you selected the correct Blade Offset for the blade you are using? 

• Do you see the correct shapes in the preview window? 

• Do you need to select Rotate, Mirror or Absolute (Position) options? Do you know, with confidence, where 
your shapes are going to cut? 

• Do you need to apply any weeding options? 

Before applying Weld Text After applying Weld Text – overlap 
between letters is removed 
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3.8 Scale Calibration 

• If you were to cut out any particular shape, for example, a 10” x 10” square, you might find that it actually 
measures 9-15/16” x 10-1/32”. It will be very close to 10” x 10” but perhaps just slightly smaller or larger in 
either or both dimensions. Now this might be perfectly acceptable for the type of cutting you do. Therefore, it 
may not even be necessary to do this particular calibration.  However, if you do want to make sure your 
shapes are cut precisely to scale, the following procedure will allow you to calibrate your Skycut. 

• The calibration process can be conducted in inches, cm, or mm.  Both mm and inches will be presented 
here. In general, it is recommended that mm be used, however, if you do not have a metric ruler, then you 
can use inches instead.  

• Before beginning this calibration, make sure the Scale setting on the Skycut itself is still set to 1.0 and 1.0. 
On the control panel, go to MENU>Scale. The following window opens where you can verify that the current 
X and Y Scale values are both set to 1.0000: 

 

 

• Return to the main screen. Then pick one of the two following sections and follow the instructions.  
 
 

3.8.1 Scale Calibration Using Millimeters for Measurement 

• SignMaster has a built-in resolution routine which can be used to easily perform this calibration: 

 Go to the Vinyl Spooler window and select the Calibration tab.  

 Click on the Cutter Scale icon: 

 

 

 A new window opens where you can enter the dimensions of a square or rectangle to draw with the test 
pen. It is highly recommended that the dimensions be at least 200 mm. Note that in the current version 
of SignMaster, the display in this window is always in inches. However, you can enter values in mm by 
typing in “mm” after the number as shown:  

 

 

1. Select the 
Calibration tab 

2. Click on the Cutter Scale icon 

Initially, both X 
and Y should be 
set to 1.0000 

After setting new Scale values, 
press MENU 

Y- / Y+: Move 
up/down the 
menu 

X- / X+: Change 

Scale values 
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 Press the tab key and the 200 mm will be automatically converted into inches. Repeat with Length: 

 
 

 On the Skycut, load a sheet of paper and insert the test pen. Move the test pen to the lower right corner 
of the paper. Make sure you have proper settings for drawing and click on Cut Test to have the shape 
drawn.  

 Using a mm ruler, carefully measure the Width (left-to-right) and the Length (top-to-bottom) that drew:   

 

Width, X 
 

Length, Y 
 

Feed the mat this direction 
into the Skycut 

Type in 200 mm 
exactly as shown 

Width has been 
converted to in 

Click here to start 
the drawing 

Type in 200 mm 
exactly as shown 
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 Write these measurements onto your sheet: 

 

 These values can now be entered into the same Width and Length fields, again adding “mm” after 
each number as shown: 

         

 

 

 After entering each number, the scaling percentage is automatically calculated: 

 

 

 

 Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes 
and you’ll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and 
repeat the same steps. Make sure you leave your new scale factors in place by having the following 
option marked: 

Enter actual Width and 
add “mm” 

Enter actual Length 
and add “mm” 

Calculated Scale values 

Click on Update 
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 Once your test rectangle is drawing at the correct size, the calibration process is complete.  

 

 

3.8.2 Scale Calibration Using Inches for Measurement 

• SignMaster has a built-in resolution routine which can be used to easily perform this calibration: 

 Go to the Vinyl Spooler window and select the Calibration tab. Click on the Cutter Scale icon: 

 

 A new window opens where you can enter the dimensions of a square or rectangle to draw with the test 
pen. It is highly recommended that the dimensions be at least 8 inches:  

  
 

 

 Load a sheet of paper and insert the test pen. Move the test pen to the lower right corner of the paper. 
Make sure you have proper settings for drawing and click on Cut Test to have the shape drawn.  

 Using a ruler, carefully measure the Width (left-to-right) and the Height (top-to-bottom) that drew:   

Leave this checked for 
each repeated test 

1. Select the 
Calibration tab 

2. Click on the Cutter Scale icon 

Enter Width and 
Length to use for test 
shape 

Click here to start the drawing 
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 Write these measurements onto your sheet: 

 

 Convert the measurements to decimals and enter these values into the same Width and Length fields. 
After entering each number, the scaling percentage is automatically calculated: 

            

 

Width, X 
 

Height Y 
 

Feed the mat this direction 
into the Skycut 

Enter actual Width 

and Length 

Calculated Scale 
values 
 

Click on Update 
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 Click on Update and a prompt window will ask if you want to Apply Scale Adjustment. Click on Yes 
and you’ll be back in the Vinyl Spooler window. To verify the scaling, again click on Cutter Scale and 
repeat the same steps. Make sure you leave your new scale factors in place by having the following 
option marked: 

 

 

 Once your test rectangle is drawing at the correct size, the calibration process is complete.  

 

 

  

Leave this checked 
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3.9 Test Cutting Flow Chart for the Skycut 
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3.10 Settings Form for Cutting Materials 
 
 

Material 
Material Brand or 
Source 

Blade Force Speed  
Blade 
Offset 

# 
Passes 

Other Comments 

               

               

               

               

               

               

               

               

               

               

               

               

               

               

               

        

        

        

 

© 2009- 2023 Sandy McCauley, All Rights Reserved 
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3.11 Suggested Settings for Various Materials 
 
 
IMPORTANT: These settings should be used for the initial test cut only. Adjustments may be necessary based 
on the condition of the blade, variations in the material, humidity, condition of the cutting mat, blade tip height, 
etc. Refer to Section 3.9 for a guide to adjusting settings for optimizing the test cut. 
 
Note: Speed settings are based on the number in parentheses in the Cutter Control tab. 
 

Material Type Material Brand/Source Blade Passes Force Speed Other Comments

Cardstock: light
Light: 65 lb (~176 gsm) 

Recollections
R 1 35 8

Cardstock: medium Medium: Textured Bazzill R 1 40 8 Blade tip ht = 40 Post It notes

Cardstock: heavy
Accent Opaque 270 gsm (100 

lb cover)
R 1 75 5

Chipboard: cereal 

box
 0.018" (0.4 mm) B 1 50 5 Alt: 2 passes at 40

Chipboard 0.022" (0.5 mm) B 2 75 5

Chipboard 0.03" (0.76mm) B 2 95 5

Chipboard 0.06" (1.5mm)
B: left 

R: right

3: on 

both

75: on 

both

1: on 

both

Duplicated image- right side cut / half-blade 

exposure; left side cut at required blade 

exposure; Blade tip ht = 20 Post It notes

Clay
Use a clay press (or pastry 

machine) to make clay thin
B 1 11 10

Make sure pinch wheels will not cross over the 

clay. Blade holder mounted on top of black seat.

Copy Paper Most any brand R 1 30 8

Fabric - Cork embroiderygarden.com B 2 40 5
Blade tip ht = 25 Post It notes; use an extra sticky 

mat and taped around edges. Brayered well.

Faux Leather
~ 1.2 mm thick from Art of 

Fabric Folding (on Etsy)
B 1 50 6

Extra sticky mat w/ material upside down. (mirror 

imagem, as needed)

Faux Leather
AOUXSEEM 1 mm (available 

on Amazon)
B 2 50 8

Extra sticky mat w/ material upside down. (mirror 

imagem, as needed)

Foam - Plain 2 mm B 2 25 10

Foam - Glitter Foamy - 2 mm R 2 15 10

Magnet
Marietta Magnetics - 0.02" 

(0.5mm) (20 mil)
B 2 90 8

Magnet 0.035" (0.9mm) B 2 50 3 Alt: 1 pass at 85

Magnet
Marietta Magnetics - 0.02" 

(0.5mm) (20 mil)
B 2 90 8
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Material Type Material Brand/Source Blade Passes Force Speed Other Comments

Tracing Paper Helix Vellum Paper R 1 30 8

Vinyl - Heat Transfer Siser EasySubli - with the mat R 1 30 8 Cut on the mat

Vinyl - Heat Transfer
Siser Glitter - Gold - No cutting 

mat
R 2 35-40 7

2 passes makes it easier to weed, also slight 

scratch cut in the backing layer

Vinyl - Heat Transfer
Siser Glitter - Gold - with the 

mat
R 2 45-50 7

2 passes makes it easier to weed, also slight 

scratch cut in the backing layer

Vinyl - Wall (no mat) Vinyl - Oracal 631 - yellow R 1 25 8

Vinyl - Wall (on mat) Vinyl - Oracal 631 - yellow R 1 30 8

Vinyl - Waterproof Papilio R 1 30 8
 

 

© 2009- 2023 Sandy McCauley, All Rights Reserved 

 

• The latest updates to these settings can be found at this link. 
  

https://docs.google.com/spreadsheets/d/19oUdlb7VZXsrN0s062wjvpo_C7giT9fIdduq9AGodu4/edit?usp=sharing
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Appendix A  Troubleshooting FAQ’s 

 
 
 

A1 Communication Issues 

 
I cannot get the Skycut to power on. 

• Make sure the power cable is securely plugged into the Skycut’s port on the left side and securely 
plugged into a wall socket or a power strip. 

• If it still fails, check the wall socket or power strip with another device, such as a table lamp. 

• If you still cannot get the Skycut powered on, contact your dealer. 

____________________ 

 

I cannot get Wi-Fi to work with my Skycut. 

• Set the Skycut close to the router when performing the initial setup presented in Section 2.2.2.  After 
establishing communication, you can test how far the Skycut can be located from your router. 

• In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have selected TCP 
and entered the same IP address you selected during setup on the Skycut’s control panel: 

 

• Make sure your computer is connected to the same router as your Skycut. 

• Verify that SignMaster is the selected software on the control panel under Set>Sys Information. 

• If the number you see on the control panel orange strip reads 192.168.16.254, you have NOT 
connected to your router. That is the default IP address for a stand-alone connection. You need to 
repeat the scan procedure and make sure you see the correct IP Address appear. 

• Some routers will not accept 200 or higher as an IP Address assignment. Try 151 instead. 

• Some routers assign the same name to both the 2.4G and 5G networks and because the Skycut’s Wi-Fi 
chip only works on 2.4G, you might need to rename your 2.4G network to a different name.  

____________________ 

 

I cannot get USB to work with my Skycut. 

• Unplug/replug the USB cable at both the computer and at the Skycut. 

• In SignMaster’s Vinyl Spooler window, under the Connection tab, make sure you have Direct USB 
Port selected under Port Type and the Status says Device Connected. If not, repeat the instructions 
in Section 2.3.1. 
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• Try a different USB port on your computer. 

• Verify that SignMaster is the selected software on the control panel under Set>Sys Information. 

• Try a different USB cable.  

 

____________________ 

 
 

A2 Operating Issues 

My mat is rotating when the Skycut starts to cut! 

• Two pinch wheels need to be gripping the mat. Move the mat either left or right so that it is under two 
outer pinch wheels and the pinch wheels are aligned under white arrows. Refer to Section 1.08. 

• Make sure you are not trying to force the blade to cut too deeply and/or too quickly through a 
thick/dense material like chipboard or craft plastic.  Slow the speed, decrease the Force, and use more 
passes. 

____________________ 
 
 
My vinyl isn’t feeding evenly while cutting. It starts bunching up on the inside of the end cap. 

• Even if you feel the vinyl is aligned properly at the start of the cut, a slight “out of alignment” error will 
become more pronounced with a long cut. When you first drop the pinch wheels, use the arrow keys to 
feed the vinyl for the length of the cut to make sure it is feeding straight. If not, then about half-way 
through the length of the vinyl needed, lift the pinch wheels and realign the vinyl. Continue testing the 
alignment until you can verify that the vinyl is sufficiently aligned for the entirety of your project.  

 
____________________ 

 
 
The pinch rollers are not tight enough to hold the vinyl I’m cutting. The vinyl is slipping and rotating when I start 
the cut. 

• The pinch wheels need to be over grit shafts (the dark gray rough areas along the revolving shaft. The 
white rectangles will help you align the pinch wheels in correct locations. Also, use outside locations 
versus having, say, one pinch on the far right of the vinyl and a second pinch wheel only in the middle.  

 
____________________ 

 
 
I hear a terrible stuttering sound when trying to cut chipboard (or other thick dense material). 

• That can be a symptom of forcing the blade to cut too deeply and/or too quickly through the chipboard. 
Slow the speed, decrease the Force, and use more passes. 

 
____________________ 
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The Skycut stopped during a cut. 

• If the Skycut stops with the head over on the left side of the cutter, you have most likely exceeded the 
cutting range. Several things to consider:  

 Check the width (W) of your project (or the height H if in Landscape mode). It cannot exceed 24”. 

 Check how far you are moving the head to the left when setting the origin. If your project is 21” and 
you moved the head more than 3” to the left, you will send the cut out of range and the cutter will 
stop. 

• If the Skycut stops and the head is not located near the left side: 

 Make sure it’s not a communication issue. 

 You may have exceeded a buffer limit. Try reducing the number of nodes. Select the shapes and go 
to Curves>Node Editing>Reduce Nodes (Object).   

____________________ 

 
 

A3 Cutting/Drawing Issues 
 

I’m getting some stray cuts added, as if the cutter is going a bit crazy. 

• Extra stray cuts can occur anywhere, including sharp V-shaped cuts jutting outside the borders of the 
project. These are referred to as random cuts and are difficult to diagnose. But based on experiences 
reported by owners of professional vinyl cutters, here are some possible causes to check: 

 Bad or defective USB cable 

 Cutter is plugged into a power strip that isn’t rated highly 

 Static electricity (many vinyl pros recommend grounding cutters to prevent random cutting due to 
static) 

 Unknown cause – sometimes a quirk in the file might cause something strange to happen such as a 
stray cut or a sudden stoppage. Try altering the file in some way, such as reducing nodes. 

 
____________________ 

My shapes are drawing (cutting) off the material. What am I doing wrong? 

• When setting the origin, make sure you are using the tip of the blade as the reference point and set the 
tip inside the corner of the material (not too close to an outside edge). 

• Verify that the preview window in SignMaster matches where you expect the shapes to cut as you view 
the material loaded into the Skycut itself. 

____________________ 

 

When drawing with the test pen), I have extra lines being drawn. 

• Make sure you raise the pen in the blade holder seat on the Skycut before tightening the screw. The 
blade holder seat needs to be able to drop the tool down when it reaches the spot to start the shape. 
Otherwise, the tool tip will be dragging across the material from the origin to where the shape will begin 
and then back to the origin at the end of the “cut”. 

____________________ 
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I’m drawing with a pen and there are bubbles at the corners. 

• For perfect corners when using a pen, go to the Send to be Cut window and select Pen Mode so that 
Blade Offset is set to 0. You do not need an offset for pens (or other tools like embossers and 
engravers).  

 

____________________ 
 

 
My cut started out fine but by the end of the cut, it’s not cutting through the material. 

• Make sure the blade holder housing doesn’t have any bits of material inside of it. 

• Make sure the screw on the blade holder seat is hand-tight so that the blade holder isn’t slipping 
upwards during the cut. 

• Make sure the cutting mat is clean and sticky and the material is pressed down completely, so that the 
material remains stabilized during the cut.  

• Make sure the blade isn’t cutting too deep into the mat. This can sometimes cause the material to be 
pulled up and away from the mat as the blade releases from the plastic it is cutting. 

• Try increasing the Force by ~ 5 – 10. 

____________________ 
 

 
My cut is clean in some places but not in others. Why am I not getting consistent cutting? 

• Make sure your material is pressed firmly onto a clean and sticky mat (assuming you are cutting a 
material such as paper or cardstock). 

• Your material may require two passes if it’s not homogenous or if it is heavily textured. Sometimes 
intricate shapes also cut better with two passes. 

• Also, if the material has been exposed to humidity, then it will become difficult to cut in one pass.  You 
can dry both paper and cardstock using a blow dryer or in a very low-temperature oven.   

• If you are cutting vinyl without a cutting mat, check the cutting strip to make sure it is still in good 
condition. 

____________________ 

 
I have the outside edges of my chipboard completely taped but I’m not getting clean cuts, even after lots of 
passes. 

• Taping the edges prevents shifting of the chipboard but it’s not enough for stabilizing. You need to 
thoroughly press the entire surface of the chipboard onto a clean and sticky mat. Using a brayer is 
recommended. 

____________________ 
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I am getting a lot of tearing in my cuts. 

• A number of things can cause tearing so work through this check list:  

 Too much blade is exposed. If you see cut lines in your mat or the backing sheet, shorten the blade 
exposure. You should only be cutting through the material itself.  

 The blade is chipped. Try a different blade. 

 The paper is not adhered well to the mat. Make sure the mat is clean, sticky, and the paper is 
pressed smoothly and evenly on the surface. 

 You may be using too much Force. Try reducing it and doing test cuts.  

 You may have too many nodes in the shape. Select the shapes and go to Curves>Node 
Editing>Reduce Nodes (Object).   

 The material itself may be subject to tearing, especially on intricate cuts.  Also, if the cardstock has 
been exposed to humidity, then the moisture in the material can make it difficult to cut cleanly. You 
can dry paper and cardstock using a blow dryer or in a very low-temperature oven.   
 

____________________ 

 
I’m cutting very small lettering and the letters are a bit distorted. 

• Verify that you are using the correct Blade Offset. 

• Try slowing down the cut. Small lettering needs slower speed. 

____________________ 

My cut shapes are not the same dimensions as what they are set to in SignMaster. 

• Perform the calibration procedure shown in Section 3.8. 

____________________ 

 
My shapes are not completely cutting out. They are still attached to the waste part of the material.  

• Make sure you have set an appropriate Overcut setting. 

• Make sure the mat is not skewing during the cut. This can happen if even one of the pinch wheels is no 
longer centered under a white arrow.  It can also happen if the speed and/or pressure is set too high. 

 
_____________________ 

 
My cardstock is not cutting all the way through. I have the blade all the way out and using the maximum force. 

• Please refer to Section 1.7.4. It’s important to only have as much blade exposed as is necessary to 
penetrate the cardstock. You may also need to raise the blade tip height (Section 3.1.3). Reduce your 
force back to suggested values for the material you are cutting and do a test cut. 

• Do not use more force than is needed. If the cardstock is cutting through about 90% of the cut, then 
increase Passes. Some cardstocks do better with a second pass at a lower force. 

____________________ 
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Appendix B:  Wireless Stand-Alone Connection 
 

• It’s usually best to connect the Skycut while it is next to the wireless computer.  Once connectivity is 
established, you can then experiment to see how far from the computer the Skycut can be located.  

• There are two situations to consider before getting started. If you are not sure which applies to your Skycut, 
then select B and go to that section first.  

A. The Skycut has never been set up wirelessly to a network. 

B. The Skycut has previously been connected to a wireless network.  

A. The Skycut has never been set up wirelessly to a network 

• Power on the Skycut and wait for the light to come on.  In the orange strip on the control panel, it should 
read either “Hi-Link” or “Cutter”, followed by some alphanumeric characters and then the IP Address: 
192.168.16.254.  If something else is shown there, proceed to Section B.  

• On your computer, open your list of available networks. In the list, you should see one with this type of name 
format. 

• Select that network and enter the following Network Key when prompted: 12345678  

• Proceed to Step 9 in Section 2.2.2. Remember that your computer will not have access to the Internet or 
other network devices while in Wireless Stand-alone mode. 

B. The Skycut has previously been connected to a network 

• On the control panel, press the MENU button, select WIFI, and press OK. Use the Y- button to move down 
to highlight Default and press OK.  

 

• Wait a minute or two and the default IP Address will then appear in the orange strip at the top of the 
display. 

• On the control panel, select Set and then select Wifi. The Wifi screen will appear:  

Select Default 

Press OK  
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• To reset the Skycut so that it will be found as an available network, press and hold the Default button for 3 
seconds. Release and you should see then see the Apply button displaying Wait. In a minute the Apply 
should return and you can then proceed back to A and use the same procedure as if the Skycut was never 
set up on a network. 

 

Press and 
hold Default 

 

Click on Wifi  
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